# Table of Contents

1 Food Safety Plan Builder v.1.2 Legal Disclaimer .......................................................... 1
2 Introducing Food Safety Plan Builder ............................................................................. 2
3 Installing Food Safety Plan Builder ................................................................................ 4
   3.1 System Requirements ................................................................................................. 4
   3.2 Download/Installation Instructions ............................................................................ 5
      3.2.1 UNINSTALL ....................................................................................................... 5
      3.2.2 DOWNLOAD .................................................................................................... 5
      3.2.3 UNZIP ............................................................................................................. 6
      3.2.4 INSTALL ......................................................................................................... 6
4 Objective ......................................................................................................................... 7
4.1 Quick Start Dialog ........................................................................................................ 7
4.2 Menu Item Features ..................................................................................................... 8
4.3 Tab Sections ................................................................................................................ 13
4.4 Features throughout the application .......................................................................... 16
5 Facility Information Tab ................................................................................................ 18
   5.1 Adding Facility Identifier Numbers ......................................................................... 19
   5.2 Delete Facility Identifier Numbers ......................................................................... 19
   5.3 Adding Food Safety Team Members ....................................................................... 20
   5.4 Deleting Food Safety Team Members .................................................................... 20
6 Preliminary Steps ........................................................................................................... 21
7 GMP & Other Prerequisite Programs ......................................................................... 27
8 Hazard Analysis and Preventive Controls Determination .......................................... 31
   8.1 Adding Process Steps by Importing ....................................................................... 31
   8.2 Add Process Steps Manually: ................................................................................ 32
   8.3 Identifying Hazards and Preventive Controls ....................................................... 34
9 Process Preventive Controls ......................................................................................... 44
   9.1 Importing Process Preventive Controls ................................................................. 44
   9.2 Documenting Process Preventive Controls ............................................................ 45
10 Food Allergen Preventive Controls ............................................................................. 46
   10.1 Importing Food Allergen Preventive Controls ....................................................... 46
   10.2 Documenting Food Allergen Preventive Controls ............................................... 47
11 Sanitation Preventive Controls .................................................................................... 48
   11.1 Food Safety Hazards Requiring a Sanitation Preventive Control ......................... 48
   11.2 Documenting Sanitation Preventive Controls ....................................................... 49
12 Supply-Chain Preventive Controls .............................................................................. 50
13 Recall Plan ..................................................................................................................... 58
14 Reanalysis of Food Safety Plan .................................................................................... 59
15 Food Safety Plan ........................................................................................................... 62
16 Signature ....................................................................................................................... 64
   16.1 Electronic Signature ............................................................................................. 64
   16.2 Updating an Electronically Signed Food Safety Plan ............................................ 66
   16.3 Manual Signature ................................................................................................. 67
17 Recordkeeping Procedures ............................................................................................ 69
Table of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 1</td>
<td>Food Safety Plan Builder Introduction</td>
<td>2</td>
</tr>
<tr>
<td>Figure 2</td>
<td>Tabs in the FSPB tool</td>
<td>3</td>
</tr>
<tr>
<td>Figure 3</td>
<td>FSPB Tool Download</td>
<td>5</td>
</tr>
<tr>
<td>Figure 4</td>
<td>UZIP file</td>
<td>6</td>
</tr>
<tr>
<td>Figure 5</td>
<td>Install Food Safety Plan Builder Tool</td>
<td>6</td>
</tr>
<tr>
<td>Figure 6</td>
<td>Quick Start Dialog</td>
<td>8</td>
</tr>
<tr>
<td>Figure 7</td>
<td>FSPB Main Menu Items</td>
<td>8</td>
</tr>
<tr>
<td>Figure 8</td>
<td>File Menu</td>
<td>9</td>
</tr>
<tr>
<td>Figure 9</td>
<td>File Menu Export</td>
<td>10</td>
</tr>
<tr>
<td>Figure 10</td>
<td>Edit Menu</td>
<td>11</td>
</tr>
<tr>
<td>Figure 11</td>
<td>View Menu</td>
<td>11</td>
</tr>
<tr>
<td>Figure 12</td>
<td>Tools Menu (default view)</td>
<td>12</td>
</tr>
<tr>
<td>Figure 13</td>
<td>Help Menu</td>
<td>13</td>
</tr>
<tr>
<td>Figure 14</td>
<td>Tree View Navigation</td>
<td>13</td>
</tr>
<tr>
<td>Figure 15</td>
<td>Middle Panel</td>
<td>14</td>
</tr>
<tr>
<td>Figure 16</td>
<td>Supplementary Information</td>
<td>15</td>
</tr>
<tr>
<td>Figure 17</td>
<td>Introduction Pop-Up</td>
<td>16</td>
</tr>
<tr>
<td>Figure 18</td>
<td>Warning Message</td>
<td>16</td>
</tr>
<tr>
<td>Figure 19</td>
<td>Question Preview</td>
<td>17</td>
</tr>
<tr>
<td>Figure 20</td>
<td>Facility Information Tab</td>
<td>18</td>
</tr>
<tr>
<td>Figure 21</td>
<td>Add Product Name</td>
<td>21</td>
</tr>
<tr>
<td>Figure 22</td>
<td>Questions 1a through 2c for each Product</td>
<td>22</td>
</tr>
<tr>
<td>Figure 23</td>
<td>Question 3a</td>
<td>22</td>
</tr>
<tr>
<td>Figure 24</td>
<td>Question 3a Add Product/Process Name</td>
<td>23</td>
</tr>
<tr>
<td>Figure 25</td>
<td>Question 3a Add Process Step</td>
<td>23</td>
</tr>
<tr>
<td>Figure 26</td>
<td>Question 3a Add Multiple Process Steps</td>
<td>24</td>
</tr>
<tr>
<td>Figure 27</td>
<td>Question 3a Delete Process Step</td>
<td>24</td>
</tr>
<tr>
<td>Figure 28</td>
<td>Question 3a before Renumbering Process Steps</td>
<td>25</td>
</tr>
<tr>
<td>Figure 29</td>
<td>Question 3a after Renumbering Process Steps</td>
<td>25</td>
</tr>
<tr>
<td>Figure 30</td>
<td>Question 3b — Verify the Flow Diagram(s)</td>
<td>26</td>
</tr>
<tr>
<td>Figure 31</td>
<td>GMP &amp; Other Prerequisite Programs Questions</td>
<td>28</td>
</tr>
<tr>
<td>Figure 32</td>
<td>Add Additional Prerequisite Programs</td>
<td>28</td>
</tr>
<tr>
<td>Figure 33</td>
<td>Edit Additional Prerequisite Programs</td>
<td>29</td>
</tr>
<tr>
<td>Figure 34</td>
<td>Edit Additional Prerequisite Programs Details</td>
<td>29</td>
</tr>
<tr>
<td>Figure 35</td>
<td>Delete Additional Prerequisite Programs</td>
<td>30</td>
</tr>
<tr>
<td>Figure 36</td>
<td>Delete Additional Prerequisite Programs Confirmation</td>
<td>30</td>
</tr>
<tr>
<td>Figure 37</td>
<td>Import Process Steps Option</td>
<td>32</td>
</tr>
</tbody>
</table>

APPENDIX A: RESOURCES AND ASSOCIATED WEB LINKS ........................................... 78

APPENDIX B: KEY TERMS ......................................................................................... 79
1 Food Safety Plan Builder v.1.2 Legal Disclaimer

The Food Safety Plan Builder (FSPB) v.1.2 is a user-friendly tool designed to help owners and operators of a food establishment with the development of a food safety plan that is specific to their facilities. The food safety plan is developed using a systematic approach to identify those hazards that require preventive controls to prevent foodborne illness or injury. A food safety plan must contain those components that are needed to be in compliance with the Current Good Manufacturing Practice, Hazard Analysis, and Risk-based Preventive Controls for Human Food rule (21 CFR part 117, or “CGMP & PC for Human Food Rule”) requirements in Subpart C — Hazard Analysis and Risk-Based Preventive Controls. A food safety plan is a set of written documents that is based on food safety principles and incorporates hazard analysis and preventive controls, including supply-chain programs and a recall plan. It delineates the procedures to be followed for monitoring, corrective actions and verification. Although the content of the Food Safety Plan Builder v.1.2 is consistent with the U.S. Food and Drug Administration's (FDA) existing regulations and guidance, use of the Food Safety Plan Builder by owners and operators of food facilities does not imply FDA approval of the resultant food safety plan. The Food Safety Plan Builder v.1.2 is a desktop tool that resides only on the user's computer. FDA does not track or monitor its use and does not have access to any content or documents saved using this tool.

FDA has taken all reasonable precautions in creating the Food Safety Plan Builder v.1.2 and the documentation accompanying it. However, FDA is not responsible for errors, omissions or deficiencies regarding the tool and the accompanying documentation. The Food Safety Plan Builder and the accompanying documentation are available for download “as is” and without warranties of any kind, either expressed or implied, including, but not limited to, warranties of performance, merchantability, and fitness for a particular purpose. FDA is not making a commitment in any way to regularly update the tool and the accompanying documentation.

Responsibility for the interpretation and use of the Food Safety Plan Builder v.1.2 and of the accompanying documentation lies solely with users. In no event shall FDA be liable for direct, indirect, special, incidental, exemplary or consequential damages (including, but not limited to, procurement of substitute goods or services, loss of use, data, or profits, or business interruption) however caused and on any theory of liability, whether in contract, strict liability, or tort (including negligence or otherwise) arising in any way out of the use of this software, even if advised of the possibility of such damage.

Third parties use of or acknowledgment of the tool and its accompanying documentation does not in any way represent an FDA endorsement of such third parties.
2 Introducing Food Safety Plan Builder

Figure 1: Food Safety Plan Builder Introduction

The U.S. Food and Drug Administration’s (FDA) Food Safety Plan Builder (FSPB) is a user-friendly, stand-alone application designed to assist owners/operators of a food facility in the development of a personalized food safety plan as required by the Current Good Manufacturing Practice, Hazard Analysis, and Risk-Based Preventive Controls for Human Food rule. A properly developed and implemented food safety plan enables owners and operators of a food facility to shift their focus from responding to contamination to preventing it. A food safety plan is a set of written documents based on food safety principles and is developed using a systematic approach to identify those hazards that require preventive controls to prevent foodborne illness or injury. The FSPB tool guides users through a series of tabs (Figure 2) which, when completed, make up the content for a comprehensive food safety plan for the facility.
The Food Safety Plan Builder is a desktop Windows application that resides only on your desktop computer. Food safety plans can be stored on local hard drives or other locations (e.g., flash drive, server, etc.) They may also include sensitive information; so it is the user's responsibility to ensure files are saved in a secure location. The FDA does not track or monitor use of the Food Safety Plan Builder, nor does it have access to any content or documents developed using this tool.

Use of this tool is strictly optional. FDA does not require use of this tool to develop a facility’s food safety plan. Although the content of the Food Safety Plan Builder is intended to be consistent with FDA’s existing regulations and guidance, use of this tool neither confers FDA approval nor implies automatic compliance of a facility’s food safety plans, preventive controls, good manufacturing practices and other food safety procedures with the regulations.

Figure 2: Tabs in the FSPB tool
3 Installing Food Safety Plan Builder

3.1 System Requirements
For FSPB to operate correctly, users’ computer configurations must meet the minimum requirements outlined in the table below.

<table>
<thead>
<tr>
<th>Components</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>2.80 GHz</td>
<td>3.0 GHz</td>
</tr>
<tr>
<td>RAM</td>
<td>512 MB</td>
<td>1 GB</td>
</tr>
<tr>
<td>Hard Disk Space</td>
<td>100 MB</td>
<td>125 MB</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows 7</td>
<td>Windows 7, Windows 10</td>
</tr>
<tr>
<td>.NET Application Framework</td>
<td>4.0</td>
<td>4.0</td>
</tr>
<tr>
<td>Graphics Card</td>
<td>VGA</td>
<td>VGA</td>
</tr>
</tbody>
</table>

Other than the computer operating system, no additional software is needed to run the application's executable file. This software is not MAC compatible.
3.2 Download/Installation Instructions

3.2.1 UNINSTALL
If you have a previous version of the application, uninstall completely from your computer and continue with step 2.

1. Click the Start button, type Programs and Features in the search box, and then select Programs and Features.
2. Under Programs and Features, select "Food Safety Plan Builder" and then click Uninstall.
3. Delete the "FoodSafetyPlanBuilderInstall_V(old version)" folder from your local C: Drive and continue with the next step.

For more detailed instructions in how to remove a program from your computer on different version of Windows, you can visit the following links: Uninstall Programs in Windows 7; Uninstall Programs in Windows 8; Uninstall Programs in Windows 10.

3.2.2 DOWNLOAD
Click the Download Food Safety Plan Builder button.

![Image of FSPB Tool Download]

Figure 3: FSPB Tool Download
3.2.3 UNZIP

Using Windows File Explorer, locate, right-click and unzip the Food Safety Plan Builder WinZip download file to your local C: Drive. **DO NOT OPEN THE DOWNLOAD FILE VIA YOUR INTERNET BROWSER.**

![Figure 4: UZIP file](image)

3.2.4 INSTALL

Using Windows File Explorer, locate and execute the Food Safety Plan Builder installation (manifest) file in the “Unzip File Destination Folder”. Once the installation is complete, the Food Safety Plan Builder will automatically start.

![Figure 5: Install Food Safety Plan Builder Tool](image)
4 Objective

This User Guide provides instructions for the following:

- Quick Start Dialog
- Facility Information
- Preliminary Steps
- Good Manufacturing Practices (GMP) & Other Prerequisite Programs
- Hazard Analysis & Preventive Controls Determination
- Process Preventive Controls
- Food Allergen Preventive Controls
- Sanitation Preventive Controls
- Supply-Chain Preventive Controls
- Recall Plan
- Reanalysis of Food Safety Plan
- Food Safety Plan
- Signature
- Recordkeeping Procedures
- Important Contacts
- Supporting Documents

4.1 Quick Start Dialog

In the Quick Start Dialog (Figure 4), you can choose to create a new plan or open a saved plan. Should you have any Food Safety Plan Builder files saved; the tool will automatically list those in the recent files list. You can also select “Getting Started” to view the User Guide.

- Getting Started — Select "Getting Started" to view the food safety plan User Guide.
- New — Select "New" to create a new food safety plan.
- Open — Select "Open" to open an existing food safety plan.
- Choose Recently Edited File — Open an existing file from the list of recently edited files, by either double-clicking the file name or by selecting an existing file from the list and clicking the "Open" button.
- Do Not Show Again — Select "Do Not Show Again" to disable the pop-up box.
4.2 Menu Item Features

**Main Menu:** The Main Menu options (“File”, “Edit”, “View”, “Tools” and “Help”) (Figure 5) are very similar to those found in other Microsoft Windows applications with which you may be familiar.
File Menu: The “File” menu (Figure 6) has options such as “Create a New Plan”, “Open an Existing Plan”, “Close”, “Save”, “Export”, or “Print”.

- **New** - Creates a new food safety plan
- **Open** - Opens an existing food safety plan
- **Close** - Closes the current food safety plan (user is prompted to save the file before closing)
- **Save** - Saves updates to the individual tabs in the food safety plan
- **Save As** - Saves the food safety plan as a whole with a new naming convention
- **Export** - Selects an individual tab and print or save to a .PDF file
- **Print** - Prints the current tab
- **Print Preview** – Displays the current tab report exactly as it will be printed
- **Print All** - Prints all of the tabs in the food safety plan
- **Recent Files** — Displays all recently opened files in FSPB
**Export Menu:** The “Export” menu (Figure 7) opens a preview window of the individual tab you have selected and gives options for saving the selected tab as an Excel, Word or PDF file. Note that the Food Safety Plan can only be saved as a PDF file.

![Figure 9: File Menu Export](image-url)
**Edit Menu:** The “Edit” menu (Figure 8) provides option(s) to Undo, Redo, Cut, Copy, and Paste information.

![Figure 10: Edit Menu](image)

**View Menu:** The View Menu (Figure 9) displays a list of all of the tabs in FSPB. Selection of one of the items from the list takes you directly to the designated tab in the food safety plan.

![Figure 11: View Menu](image)
**Tools Menu:** To customize certain FSPB options, check or uncheck the Tools Menu options (Figure 10).

![Figure 12: Tools Menu (default view)](image)

- **‘Show Introduction Pop-Up Message’** – By default this option is checked. Unchecking this option will prevent the Introduction Pop-up box instructions from appearing for all the tabs when each tab is clicked on for the first time.

- **‘Show Quick Start Dialog’** – By default this option is checked. Unchecking this option will prevent the ‘Quick Start Dialog’ box that normally appears when users start the FSPB application from appearing.

- **‘Print Report Header’** – By default this option is checked. This option allows you to print a customized message (The default message being ‘For Internal Use Only’) on every page of the report. You can also determine whether you want this header to print on every page or just the title page of the report.

- **‘Include Supply-Chain Records Document Checklist in Plan’** – By default this option is unchecked. By checking this option, the supply-chain records checklist as listed in Question 5a (for all the suppliers and ingredients) will be included in the Supply-Chain Preventive Controls tab and in the Food Safety Plan tab.

- **‘Include Recordkeeping information in Plan’** – By default this option is unchecked. By checking this option, the information entered in the Recordkeeping tab will be included in the Food Safety Plan tab.

- **‘Include Important Contacts in Plan’** – By default this option is unchecked. By checking this option, the information entered in the Important Contacts tab will be included in the Food Safety Plan tab.
**Help Menu:** The User Guide, Legal Disclaimer, and information about the software (“About”) can be accessed via the Help Menu (Figure 11).

![Figure 13: Help Menu](image)

4.3 Tab Sections
Under each tab, there are three panels: 1) Tree view navigation, 2) Middle panel, and 3) Supplementary Information

- **Tree View Navigation:** The left panel (Figure 12) contains a list of pre-populated questions, organized in a tree view by headers and sub headers. You can navigate between questions by clicking the “Next” or “Back” button at the bottom of the Middle Panel, or by clicking on the appropriate question in the Tree View. (Note: To ensure that questions are answered in the proper sequence, navigate via the “Next” button.) A green arrow indicates the question you are currently on and a black arrow indicates that a response has been entered for that question.

![Figure 14: Tree View Navigation](image)
- **Middle Panel**: The middle panel (Figure 13) is the response section. In this area you will be asked to provide responses to each question.

2. Effectiveness Checks:

2a. Describe the procedures and documentation that must be utilized to conduct effectiveness checks to verify that a recall is carried out, and who will be responsible for this activity.

Figure 15: Middle Panel
- **Supplementary Information** - The right panel (Figure 14) contains additional background and regulatory information to assist users with responding to the questions. This panel also includes a “zoom in” and “zoom out” feature for improved readability.

![Supplementary Information](image)

**Supplementary Information:**

The CGMP requirements for sanitary operations focus on ensuring that food, food contact surfaces and food packaging materials are protected against food allergen cross-contact and contamination. For additional information and resources, please see 21 CFR 117.35 and the User Guide.

**Figure 16: Supplementary Information**
4.4 Features throughout the application

- **Introduction pop-up box**: When navigating to each tab in the application, users will see an Introduction pop-up box (Figure 15) describing the tab (unless the ‘Show Quick Start Dialog’ option has been unchecked under the Tools menu).

![Figure 17: Introduction Pop-Up](image)

- **Warning message**: Throughout the application, warning messages will be displayed, as applicable (Figure 16).

![Figure 18: Warning Message](image)
• **Uploading additional documents**: If documents like Standard Operating Procedures (SOPs), records, etc. are available for a process or program, these documents can be simply uploaded and attached through the *Supporting Documents* tab. In the Comments field of the appropriate question, simply indicate the titles of the documents and that they are in the *Supporting Documents* tab.

• **Question preview**: Throughout the application, in the left tree view, you can hover over the questions/features and read details for that particular question/feature (Figure 17).

![Figure 19: Question Preview](image)
5 Facility Information Tab

In the Facility Information tab (Figure 18), information adequate to identify the plant or facility is noted with a red asterisk. The information that identifies your facility (noted with a red asterisk), such as Company/Facility Name, Address, City and State, Country, Postal Code and Facility Identifier Number(s), will appear at the top of each of the applicable tab summary reports, and at the top of your Food Safety Plan. Other information not noted with a red asterisk is not required to be entered; however, any information filled out in this tab will appear in the Food Safety Plan. Additionally, you can document the names and contact information of members of your Food Safety team, as well as indicate the Preventive Controls Qualified Individual(s) for the facility.

![Figure 20: Facility Information Tab]

The fields of the *Facility Information* tab include:

- **Facility/Company Name** — The name of the facility/company
- **Facility Identifier Numbers** — Any FDA registration or identifier numbers associated with the facility
  
  *For more information on FDA requirements for Registration of Facilities, visit: [http://www.fda.gov/Food/GuidanceRegulation/FoodFacilityRegistration/](http://www.fda.gov/Food/GuidanceRegulation/FoodFacilityRegistration/).
- **Address** — The street address where the facility is physically located
- **City** — The city where the facility is physically located
- **State** — The state where the facility is physically located
- **Postal Code** — The zip code where the facility is physically located
- **Country** — The country where the facility is physically located
- **Phone Numbers** — Phone numbers for the facility
- **Facility Description** — A general description of the facility, including any physical attributes
- **Employee Description** — Information about the facility’s employees (including number and types of (i.e. full time, part time, seasonal, etc.) employees, etc.)
- **Product Description** — A description of the specific food product(s) or product categories being processed
- **Food Safety Team** — Name, title, and phone numbers of the individual(s) involved with the development and maintenance of the food safety plan. Primary contact(s) and Preventive Controls Qualified Individual(s) responsible for preparation of the food safety plan may be identified here.

### 5.1 Adding Facility Identifier Numbers

1. To add a facility identifier to the Facility Identifier Numbers list, click the ![+] icon beside 'Facility Identifier Numbers' field.
2. Select the new row and enter the "Description" and "Number".

### 5.2 Delete Facility Identifier Numbers

To delete facility identifier numbers:

1. Select the row of the identifier to be deleted
2. Select the "Delete" icon ![−] at the top of the field

This will permanently remove an identifier from the list.
5.3 Adding Food Safety Team Members
To add an individual to the Food Safety Team list:
1. Select the [+] icon besides the 'Food Safety Team' field to insert a new row in the table
2. Select the new row to add details about the food safety team member
3. Indicate whether the contact is a Primary Contact by checking/unchecking the ‘Primary Contact(s)’ box in that row
4. Indicate whether the contact is a Preventive Controls Qualified Individual (PCQI) by checking/unchecking the ‘PCQI’ box in that row
5. Enter Name, Title and Phone details for the food safety team member, as applicable

5.4 Deleting Food Safety Team Members
To delete a Food Safety Team member:
1. Click on the row of the individual to be deleted
2. Click the [X] icon

This will permanently remove the individual's name and title from the Food Safety Team list.
6 Preliminary Steps

The Preliminary Steps tab may serve as a useful framework for organizing and documenting important food safety-related characteristics of the products manufactured at your facility. Although performing these preliminary steps is not explicitly required by the CGMP & PC Rule, it is useful to capture this information in your Food Safety Plan. In this tab, you can describe final finished products, distribution, intended use and consumers of the food(s) manufactured, processed, packed, or held at the facility. In addition, you can develop process flow diagrams by entering all steps in the manufacturing process for each product. Recommended preliminary steps in this tab include:

- Describing the food products and their distribution;
- Describing the intended use and consumers or end user of each food product;
- Developing flow diagrams and descriptions of the processes; and
- Verifying the flow diagrams on-site.

Additional reference resources regarding preliminary steps can be found in Appendix A of this User Guide.

Add a Product Name: Add a new product by entering the name of the product in the text field and clicking the "Add Product" button (Figure 19).
• To add multiple product names once you have answered Questions 1a through 2c for that product, navigate using the tree view to "Add Product Name" again and continue to answer Questions 1a through 2c for that new product. Repeat as often as necessary.
• Product names should be unique. If this is not the case, you will receive a warning message that the product name already exists and you will need to create a new product name.

Questions 1a through 2c: After adding a product, the FSPB generates a list of questions to be answered (Figure 20). Enter responses to the questions in the Comments box and click the “Next” button to navigate between questions.

Flow Diagram Process Steps:

The process steps entered here will populate the Hazard Analysis & Preventive Controls Determination tab. If you choose not to use this tab, you may manually add the process steps in the Hazard Analysis & Preventive Controls Determination tab.

Question 3a: To add a new “Product/Process Name” (Figure 21), click on the button to the right of the “Product/Process Name” dropdown menu — as highlighted below. Enter the product/process name and click the “OK” button (Figure 22).
To add process steps (Figure 23), click on the button to the right of the “Process Steps” field and enter the name of the process step in the “Process Step” field.

Repeat as necessary until all process steps have been added (Figure 24).
To delete a process step (Figure 25), select the appropriate row in the “Process Steps” grid and click the \(\times\) icon. Select “Yes” in the “Confirm Delete” dialog window to confirm deletion of the process step.
**Renumber Process Steps:**
To renumber process steps (Figures 26 and 27), select the process step to be moved and drag it to the proper place in the table (as shown below). The software will then automatically renumber the steps.

![Figure 28: Question 3a before Renumbering Process Steps](image)

![Figure 29: Question 3a after Renumbering Process Steps](image)
**Question 3b:** To verify the flow diagram for each Product/Process name (Figure 28), select the "Yes" or "No" button.

If changes to the Product/Process Name and/or Process Steps are required, return to Question 3a to edit the information in the flow diagram.

![Flow Diagram](image)

**Figure 30: Question 3b — Verify the Flow Diagram(s)**
Chapter 7

GMP & Other Prerequisite Programs

This tab serves as a checklist for the good manufacturing practice and other prerequisite programs that govern the basic facility environmental and operating conditions and provide a foundation for your Food Safety Plan. The CGMP & PC rule does not require a GMP checklist as part of the Food Safety Plan, but you may find it helpful.

In general, the CGMP regulations found primarily in 21 CFR 117 subpart B do not require written procedures, monitoring, or recordkeeping. The exception is employee training records, which must be established and maintained per 21 CFR 117.4(d) in subpart A. Although facilities subject to the CGMP & PC rule must comply with the CGMP provisions, some questions might not be relevant for your facility; in such cases, select ‘Not Applicable’.

Additional reference resources regarding GMP and other Prerequisite Programs can be found in Appendix A of this User Guide.

To start reviewing the good manufacturing practice provisions (Figure 29), navigate to “Personnel” information and answer the questions by selecting “Yes” or “Not applicable”, as appropriate. You can then navigate to the following sections: “Plant and Grounds”, “Sanitary Operations”, “Sanitary Facilities and Controls”, “Equipment and Utensils”, “Processes and Controls”, “Warehousing and Distribution of Food, and Holding of Human Food By-Products for Use as Animal Food”, as well as “Defect Action Levels” by clicking on the ‘Next’ button at the bottom of each screen.
The tab addresses the required GMPs in 21 CFR 117.4 and Subpart B. However, you may add additional prerequisite programs relevant to your facility in Question 9 (Figure 30).

- **Add** — To add an additional prerequisite program, select "Additional Prerequisite Programs" folder, enter the prerequisite program name, and click the "Add Prerequisite Program" button.
- **Edit** — To edit an added [or existing] additional prerequisite program (Figures 31 and 32), select the prerequisite program and then right click on the prerequisite program folder. Select "Edit Prerequisite Program", and update the name and/or Comment.

![Figure 33: Edit Additional Prerequisite Programs](image)

- **Delete** — To delete an added [or existing] additional prerequisite program (Figure 33), select the prerequisite program folder and then right click the appropriate "Prerequisite Program" folder. Select "Delete Prerequisite Program" and then "OK" to remove the program (Figure 34).

![Figure 34: Edit Additional Prerequisite Programs Details](image)
Figure 35: Delete Additional Prerequisite Programs

Figure 36: Delete Additional Prerequisite Programs Confirmation
8 Hazard Analysis and Preventive Controls Determination

Under 21 CFR 117.130, facilities must conduct a hazard analysis to identify known or reasonably foreseeable hazards for each type of food manufactured, processed, packed or held at a facility and determine whether any of the hazards require a preventive control. The hazard analysis must be written regardless of its outcome and must consider biological, chemical and physical hazards. The determination of whether or not a hazard requires a preventive control must consider the severity of the illness or injury if the hazard were to occur, as well as the probability that the hazard will occur in the absence of controls. The hazard analysis must be based on experience, illness data, scientific reports, and any other relevant information.

Additional reference resources regarding various types of hazards that must be considered can be found in Appendix A of this User Guide.

Process Steps entered in question 3a of the Preliminary Steps Tab can be automatically imported into this tab by selecting "Import" from the "Import Process Steps" dialog window. The process/product name and process step names will automatically appear. Alternatively, process steps can be manually added by selecting "Manually" in the "Import Process Steps" dialog box, and then selecting “Yes” in the subsequent “Warning” pop-up box. It is important to keep in mind that once the selection is made, it cannot be undone for that particular Food Safety Plan file.

Regardless of whether the process steps were automatically imported or entered manually, the Food Safety Plan Builder tool generates a list of questions to be answered for each process step.

8.1 Adding Process Steps by Importing

To import process steps from the Preliminary Steps tab (Figure 35):
  a) Select the "Import" button under “Import Process Steps".
b) Select the "Import Process/Product Names and associated Process Steps from Preliminary Steps tab" (Figure 36). Process steps from the Preliminary Steps tab will appear, along with questions to be answered for each process step (Figure 37). Please Note: You must return to the Preliminary Steps tab to make changes to the process steps in your flow-diagram. To reflect these changes in the Hazard Analysis and Preventive Controls Determination tab, you must again select the “Import Process/Product Names and associated Process Steps” button.

8.2 Add Process Steps Manually:
To add process steps manually:

a) Select "Manually" in the prompt shown in Figure 35.

b) Enter the required Product/Process Name in the text field provided (as shown in Figure 38). The product process name and associated process steps must be entered in accordance with the provided examples to ensure that the FSPB tool will properly capture the information in the proper sequence. Note that the spacing and format of the step number are critical.

For processes with up to 99 process steps, enter information in this format (enter a 'space' only where shown):

   Product/process name: Step01: Name of processing step  
   Product/process name: Step02: Name of processing step  
   Product/process name: Step03: Name of processing step

Ex.:
   Milk: Step01: Raw Milk Receiving  
   Milk: Step02: Raw Milk Storage  
   Milk: Step03: Pasteurization

For processes with up to 999 process steps, enter information in this format:

   Product/process name: Step001: Name of processing step  
   Product/process name: Step002: Name of processing step  
   Product/process name: Step003: Name of processing step

Ex.:
   Peanut butter: Step001: Receiving Shell Peanuts  
   Peanut butter: Step002: Storage of Shell Peanuts  
   Peanut butter: Step003: Processing

c) Click the "Add Product/Process Names and Associated Process Steps" button.
Once the product/process names and their associated process steps are added, the application will display the following (Figure 39):

**8.3 Identifying Hazards and Preventive Controls**

You must determine whether there are any hazards requiring a preventive control for each of the three hazard categories: Biological, Chemical, and Physical. You cannot navigate to the next question unless comments are added for all the identified hazards.

To add, edit, or delete information for any question (e.g., 1a, 2a, 2b, 2c) you must return to the specific question for that process step(s) and provide required information.
a) **Question 1a:**

To complete Question 1a:

**Step 1:** Select “Yes” or “No”, as appropriate, for all hazard categories (Biological, Chemical, Physical) (Figure 40). Each of the three types of hazards must be answered with a ‘Yes’ or ‘No’, or a warning notice will appear stating that you failed to do so, and you will be taken back to enter in the missing information.

**Step 2:** For each hazard category, select the hazard category from the dropdown menu and enter the corresponding hazard name in the “Name” text field (Figure 41).

![Figure 42: Question 1a – Selection of Hazard Categories and Hazard(s)](image)

**Step 3:** Click the “ ” button. Repeat steps 2 and 3 to add other hazards (Figure 42).

**Step 4:** Once all hazards have been entered, click the "Next" button.

*Note:* To delete a hazard, select that particular row in the grid and click the icon
b) Question 2a:
To complete question 2a (Figure 43):

Step 1: Select the Hazard Name in the “Process Step Hazards” table.

Step 2: Indicate whether a preventive control is required for each hazard by selecting the "Y" or "N" checkbox and enter justification comments for each hazard in the adjacent “Comments” text field.

Step 3: Click the "Next" button.

*Note:
- To edit comments for a hazard, select the “Comments” text field for that particular hazard and update as needed.
- If the answer to this question is “N”, the FSPB tool will automatically skip questions 2b & 2c for that hazard.
c) **Question 2b:**
To complete question 2b (Figure 44):

**Step 1:** Select the hazard name in the Process Steps Hazards table and enter the preventive control required for the hazard by selecting the type of preventive control (e.g. process, sanitation, food allergen, supply-chain) from the "Preventive Control" dropdown menu.

**Step 2:** Click the button and identify the specific preventive control in the adjacent "Comments" text field. Failure to enter the appropriate information will cause a warning notice to appear, and you will be taken back to enter the missing information.

**Step 3:** Repeat Steps 1 and 2 to add preventive controls for all hazards.

**Step 4:** After entering required information, click the "Next" button.

![Figure 46: Question 2b](Image)

*Note:*

- To edit comments for a Preventive Control (Figure 45), select the “Comments” text field for that particular Preventive Control and update comments as needed.
To edit or delete a Preventive Control (Figures 46 and 47), select that row in the table and click the \(\times\) button. Deleting the Preventive Control in Question 2b will also delete the corresponding hazard. To enter the hazard again, navigate to Question 1a and repeat steps for Questions 1a through 2b.
2b. For each hazard requiring a preventive control, indicate which type of preventive control(s) will be used to significantly minimize or prevent the hazard. Describe the preventive control that will be used in the comment box.

Figure 48: Deleting a hazard
To add the **same Preventive Control type** (eg. process, sanitation, allergen, supply-chain preventive control, etc.) for the same hazard and same process step (Figure 48): add the same hazard with a different name and then add the same preventive control type for both hazards. (Eg. If *Salmonella* is the biological hazard and will be controlled with two different process preventive controls, select “Biological” from the “Hazard” drop-down menu in 1a and add *Salmonella1* in the adjacent “Name” text field. Then, select “Biological” again from the “Hazard” drop-down menu in 1a and add *Salmonella2*. Proceed through the remaining questions for *Salmonella1* and *Salmonella2*. 
d) Question 2c:

To complete question 2c:

**Step 1:** For each hazard, select the hazard and check "Y" or "N" if a preventive control should be applied at this process step. Important: The answer to 2c determines whether or not the product/process step(s) will be exported into the appropriate Process, Allergen, and Sanitation Preventive Controls tabs.

Unlike the Process Preventive Controls, Allergen Preventive Controls, and Sanitation Preventive Controls tabs, if a supply-chain preventive control is chosen, the process step(s) at which a supply-chain preventive control will be applied will **not** automatically appear in the Supply-Chain Preventive Controls tab. Instead, a pop-up dialog box will appear (Figure 49) stating that information pertaining to supply-chain preventive controls must be entered in the Supply-Chain Preventive Controls tab.
Step 2: Once Question 2c is completed for all hazards (Figure 50), click the "Next" button.

Failure to select ‘Y’ or ‘N’ for each preventive control will trigger a warning pop-up box (Figure 51) and the FSPB tool will not proceed to the next question until the missing information has been entered.
Figure 53: Validation check for Question 2c
9 Process Preventive Controls

21 CFR 117.135(c)(1) states that process controls include procedures, practices, and processes to ensure the control of parameters during operations. Process controls must include, as appropriate to the nature of applicable preventive control and its role in the facility’s food safety system:

1. Parameters associated with the control of the hazard, and
2. The maximum or minimum value, or combination of values, to which any biological, chemical, or physical parameter must be controlled to significantly minimize or prevent a hazard requiring a process control.

Additionally, 21 CFR 117.140 states that, except for supply-chain preventive controls and the recall plan, preventive controls are subject to preventive control management components including monitoring, corrective actions and corrections, and verification. Verification procedures include validation, verification of monitoring, verification that decisions about corrective actions are being made appropriately, calibration of monitoring and verification instruments, product testing, environmental monitoring, and review of records.

Additional reference resources regarding process preventive controls can be found in Appendix A of this User Guide.

To begin answering questions pertaining to process preventive controls, select “Import Hazard(s) Requiring Process Preventive Control(s)”. The tool will list the process steps identified in the hazard analysis at which process preventive controls will be applied to control specific hazards and generate questions pertaining to each process step.

9.1 Importing Process Preventive Controls

The process steps at which process preventive control will be applied that were identified in the Hazard Analysis & Preventive Controls Determination tab will be imported to the Process Preventive Controls tab. To import these process steps, click on the “Import Hazard(s) Requiring Process Preventive Control(s)” button as shown in Figure 52.

If changes to the processing steps that have been imported are needed, navigate to the Hazard Analysis & Preventive Controls Determination tab to make those changes. Then, click on the “Import Hazard(s) Requiring Process Preventive Control(s)” button in this tab again to reflect those changes.
9.2 Documenting Process Preventive Controls

Once the process steps and identified hazards have been imported into this tab, a number of questions pertaining to the specific process preventive controls and associated management components will be generated (Figure 53). The questions will assist in documenting information on the critical process parameters, monitoring procedures, corrective action procedures when deviations from critical limits occur, and verification procedures.
10 Food Allergen Preventive Controls

The primary goal of a food allergen preventive control program is to protect consumers susceptible to food allergens. 21 CFR 117.135(c) (2) provides that food allergen controls include those procedures, practices, and processes to control food allergens. As with other preventive controls, the need for a specific food allergen preventive control is determined through the hazard analysis. Food allergen preventive controls must include those procedures, practices and processes employed for ensuring that food is protected from allergen cross-contact, including during storage, handling and use, as well as ensuring accurate labeling of the finished food product such that the food is not misbranded under section 403(w) of the Federal Food, Drug, and Cosmetic Act.

Additional reference resources regarding food allergen preventive controls can be found in Appendix A of this User Guide.

To begin answering questions pertaining to allergen preventive controls, select "Import Hazard(s) Requiring Allergen Preventive Control(s)". The tool will list the process steps identified in the hazard analysis at which allergen preventive controls will be applied to control specific hazards and also generate questions pertaining to each process step.

10.1 Importing Food Allergen Preventive Controls

To import hazards requiring food allergen preventive controls, click on the “Import Hazard(s) requiring Allergen Preventive Control(s)” button as shown in Figure 54.

If changes to the processing steps that have been imported are needed, navigate to the Hazard Analysis & Preventive Controls Determination tab to make those changes. Then, click on the "Import Hazard(s) requiring Allergen Preventive Control(s) tab” button in this tab again to reflect the changes.
10.2 Documenting Food Allergen Preventive Controls

These generated questions will assist in documenting the necessary information for each allergen preventive control (Figure 55). Note that some questions might not be applicable for the specific allergen preventive control. In that case, select “Not Applicable” and click “Next”.

Figure 57: Post Import
11 Sanitation Preventive Controls

21 CFR 117.135(c)(3) provides that sanitation preventive controls include procedures, practices, and processes to ensure that the facility is maintained in a sanitary condition adequate to significantly minimize or prevent hazards such as environmental pathogens, biological hazards due to employee handling, and food allergen hazards. Sanitation preventive controls must include, as appropriate to the facility and the food, procedures, practices, and processes for ensuring:

(1) Cleanliness of food-contact surfaces, including utensils and equipment; and
(2) Prevention of allergen cross-contact and cross-contamination from unsanitary objects and from personnel to food, food packaging material, and other food-contact surfaces and from raw product to processed product.

Additional reference resources regarding sanitation preventive controls can be found in Appendix A of this User Guide.

To begin answering questions pertaining to sanitation preventive controls, select “Import Hazard(s) requiring Sanitation Preventive Control(s)”. The tool will list the process steps identified in the hazard analysis at which sanitation preventive controls will be applied to control specific hazards and also generate questions pertaining to each process step.

11.1 Food Safety Hazards Requiring a Sanitation Preventive Control

To import the hazards requiring Sanitation Preventive Controls, click on the "Import Hazard(s) requiring Sanitation Preventive Control(s)" button as shown in Figure 56.

If changes to the process steps that have been imported are needed, navigate to the Hazard Analysis & Preventive Controls Determination tab to make those changes. Then, click on the "Import Hazard(s) requiring Sanitation Preventive Control(s)" button again to reflect those changes.
11.2 Documenting Sanitation Preventive Controls

Answering these generated questions (Figure 57) will assist in documenting the necessary information for each sanitation preventive control.

Figure 58: Import Hazard(s) requiring Sanitation Preventive Control(s)

Figure 59: Post Import
12 Supply-Chain Preventive Controls

Under 21 CFR 117.405, a receiving facility must establish and implement a risk-based supply-chain program for those raw materials and other ingredients for which it has identified a hazard requiring a supply-chain-applied control. The goal of the supply-chain program is to provide assurance that the hazard requiring a supply-chain-applied control has been significantly minimized or prevented. The supply-chain program must include using approved suppliers, determining appropriate supplier verification activities, including frequency at which the verification activities will be conducted, and, when appropriate, reviewing documentation of supplier verification activities conducted by another entity.

Unlike the Process Preventive Controls, Allergen Preventive Controls, and Sanitation Preventive Controls tabs, process steps at which a supply-chain preventive control will be applied cannot be automatically imported into this tab, due to the structure of this tab.

Additional reference resources regarding supply-chain preventive controls can be found in Appendix A of this User Guide.

The first set of questions in this tab (Figure 58) will guide you through determining if you are required to develop and implement a supply-chain program. If the supply-chain program requirements apply to your facility, the remaining questions in the tab will guide you through documenting the supplier approval process, including factors that you consider when assessing a potential supplier, supplier- and ingredient-specific information, the hazard(s) being controlled by the supplier, and supplier verification activities.

Figure 60: Supply-Chain Preventive Controls tab
In this tab, answers to certain questions cause the tool to navigate to a subsequent question that might not be the question that appears immediately below the question that was just answered in the left panel tree view (Figure 59). This is a deliberate feature intended to help prevent you from answering questions that are not relevant to your facility. Please note that this feature only works if the “Next” and “Back” buttons at the bottom of each screen are utilized (instead of manual navigation via the tree view).

Figure 61: Navigation to subsequent questions

An additional unique feature of this tab is the ability to select how the information captured in this tab is organized in an exported report. In addition to exporting the tab in its entirety, information can be organized by Supplier or by Ingredient. Additionally, the Supply-Chain Document Checklist Report can be exported as a standalone record. Note that this Supply-Chain Document Checklist Report is not automatically included in your overall food safety plan. To include this checklist in the food safety plan, select “Include Supply-Chain Document Checklist Report in Plan” under the “Tools” menu (Figure 60).
In the first section, Requirement for a Supply-Chain Program, users will answer three questions to determine whether a supply-chain program is required (Figure 61).

**Step 1:** Answer questions 1a – 1c. After answering questions 1a-1c, if a supply-chain program
is not required, a pop-up box will appear (Figure 62) asking you to provide a justification in the “Comments” box to support such a conclusion.

![Figure 64: Justification message]

**Step 2:** Approved suppliers are added in Section 2 – Using Approved Suppliers

**Note:** One or multiple suppliers can be added (Figure 63).

![Figure 65: Adding a Supplier]

- To delete a supplier, right click on the supplier name and confirm deletion as shown in Figures 64 and 65.
Step 3: In Question 2b, for each approved supplier added in question 2a, one or several ingredients can be added (Figure 66).
Step 4: Select either “Yes” or “No” to answer Question 2c (Figure 67). Failure to do so will trigger a warning pop-up box to appear and the FSPB tool will not proceed to the next question until the missing information is entered.

*Note: Answers to this question affect which questions need to be answered in Section 3 & Section 5.

Step 5: Answer questions 3a through 4a.

*Note: Some answers to questions will take users to specific questions (e.g., Questions 3i, and 3k).
Step 6: To delete an ingredient, right click on the ingredient and confirm deletion as shown in Figure 69 & Figure 70.
Step 7: Question 5a is a records checklist. Select “Complete” or “Req. not applicable” as appropriate.

Figure 73: Question 5a checklist when 2c is answered ‘Yes’
13 Recall Plan

21 CFR 117.139 requires facilities that have identified a hazard requiring a preventive control to develop a written recall plan. The written recall plan must include procedures that describe the steps to be taken and assign responsibility for taking those steps, in order to perform the following actions as appropriate to your facility:

- Directly notifying the direct consignees of the food recalled, including how to return or dispose of the affected food,
- Notifying the public, as appropriate, about any hazards presented by the food,
- Conducting effectiveness checks to verify that the recall is carried out,
- Appropriately disposing of recalled food through, for example, reprocessing, reworking, diverting to a use that does not present a safety concern, or destroying the food.

Additional reference resources regarding recalls and recall plans can be found in Appendix A of this User Guide.

The questions in this tab will guide you through development of a recall plan specific to your facility (Figure 72).

![Figure 74: Recall Plan](image-url)
14 Reanalysis of Food Safety Plan

Verifying that the food safety plan is still applicable and relevant is the focus of reanalysis. 21 CFR 117.170 requires a Preventive Controls Qualified Individual (PCQI) to perform or oversee the reanalysis and also describes specific circumstances under which reanalysis of the food safety plan must be performed. In general, reanalysis of the food safety plan as a whole must occur at least once every 3 years. Additionally, reanalysis of the food safety plan as a whole, or a specific applicable portion of the plan, must be conducted whenever a significant change in the activities conducted at the facility creates a reasonable potential for a new hazard or creates a significant increase in a previously identified hazard; whenever you become aware of new information about potential hazards associated with the food; whenever appropriate after an unanticipated food safety problem; whenever you find that a preventive control, combination of controls, or the food safety plan as a whole is ineffective; and when FDA determines it is necessary to respond to new hazards and developments in scientific understanding.

To answer the first question in this tab, select the date on which the reanalysis is being conducted and identify the reason(s) for the reanalysis. The reason(s) identified for prompting the reanalysis process determines the specific questions that the FSPB tool generates after “Add Date” has been selected.

After indicating the date and the reason(s) for the reanalysis (Figure 73), click “Add Date”. If the indicated date of the reanalysis is before today’s date, a dialog box will appear and ask for an explanation as to why this information was not recorded at the time of the reanalysis (Figure74). The FSPB tool does not permit the addition of more than one reanalysis with the same date. An error pop-up box will appear indicating that you have already entered this reanalysis date (Figure 75).
Figure 75: Reanalysis Tab

Figure 76: Selecting a past date

Figure 77: Selecting the same date
Note that once you have clicked “Add Date”, you cannot edit or delete this entry nor enter or edit information in the “Comments” box; therefore, you should carefully review the information you have entered before clicking “Add Date”.

After clicking “Add Date”, the tool will generate specific questions based on your response to question 1, which will guide you through documenting the reason(s) for reanalysis and the effect(s) on the food safety plan.
15 Food Safety Plan

The responses entered within each* of the tabs in the Food Safety Plan Builder are automatically compiled into a single document, which then serves as your facility's food safety plan. The Food Safety Plan tab will display a printable, read-only version of the food safety plan which can only be exported to a PDF file.

Additional reference resources regarding food safety plans can be found in Appendix A of this User Guide.

The Food Safety Plan tab has its own unique toolbar (Figure 76), with the following functions available to the user:

- Navigation left and right arrows: move forward and backward through the report pages
- Print: generate a paper copy of your food safety plan
- Print Layout: displays the report in a Read Only version of the food safety plan
- Page Setup: customizable options (such as margins and page orientation) for how the report is to be printed
- Save/Export: options for saving as a PDF file
- Zoom: increase or decrease the size of the report being viewed

(*does not include information in the Recordkeeping, Important Contacts, and Supporting Documents tab or the document checklists in the Supply-Chain Preventive Controls tab, unless you have chosen to include the information from these tabs)
Figure 78: Food Safety Plan

Note:
- After accessing the *Food Safety Plan* tab, first click on the screen to begin scrolling through the pages of the report.
16 Signature

The Signature tab (Figure 77) allows the food safety plan to be signed by the owner, operator, or agent in charge of the facility, as required by the CGMP and PC rule. The food safety plan can be signed electronically or manually.

To begin the signature process, select either “Electronic” or “Manual”.

16.1 Electronic Signature

To implement an electronic signature:

- Select the checkbox for "Electronic Signature"
- Select the "Acknowledgment" checkbox
- Enter the “Reviewer Name”, “Title”, and “Comments” (if any)
- Check the "Reviewed" checkbox to automatically populate the "Reviewer Signature", "Date" and "Time" fields (Figure 78)
- Navigate to the **Food Safety Plan** tab, scroll to the bottom of the last page of the plan, and verify that "Signature", "Date", and "Time" have automatically populated as shown in Figure 79.

![Figure 80: Electronic Signature](image-url)
16.2 Updating an Electronically Signed Food Safety Plan

Any attempt to modify/update a signed food safety plan will initiate a confirmation message to confirm whether you will continue editing the file, or create a copy of the existing food safety plan (Figure 80).
To continue editing the food safety plan:

- Select "Continue Editing" to delete the Electronic Signature and continue modifying the food safety plan. Keep in mind that when "Continue Editing" is selected, the original content will be lost upon modification. Additionally, the current food safety plan will need to be reviewed and signed again.
- Select "Create a Copy" to archive the current food safety plan.

The archived food safety plan will retain the previous information and signature. A "File Save As" dialog window will be displayed where you can enter a new name for the new food safety plan file. All of the information from the archived food safety plan will be retained in the new food safety plan. However, because this is a new food safety plan, the signature will be removed and the owner, operator, or agent in charge of the facility must sign the newly revised food safety plan.

16.3 Manual Signature

To implement a Manual Signature:

- Select the "Manual Signature" checkbox
- Select the "Acknowledgement" checkbox (Figure 81)
- Navigate to the Food Safety Plan tab and scroll to the bottom of the last page; "Signature" and "Date/Time" fields are displayed (Figure 82)
- Print the food safety plan and retain this hard copy of the signed plan.
**Figure 83: Manual Signature**

**Figure 84: Food Safety Plan Manual Signature Fields**
17 Recordkeeping Procedures

The Recordkeeping Procedures tab (Figure 83) serves as a checklist to determine if all records required by the CGMP & PC Rule have been developed and all mandatory recordkeeping procedures have been followed. The CGMP & PC rule does not require use or inclusion of such a checklist in the food safety plan. As such, information in this tab will not be automatically exported to the Food Safety Plan tab; to include it in the Food Safety Plan, select “Include Recordkeeping Information in Plan” in the “Tools” menu.

The Recordkeeping Procedures section follows this structure:
- Food safety plan-related questions
- Requirements applicable to implementation records
- Record retention
- Written assurances
- Employee training records
- Record review

Figure 85: Recordkeeping Procedures Tab
The questions in this tab can be answered by selecting “Yes”, “No”, or in some cases, “Not Applicable” (Figure 84), and by adding any other relevant information into the “Comments” text field, if necessary. Additionally, the name(s) of other records and/or document(s) relevant to the food safety plan can be entered in the “Comments” text field, and the document files can be uploaded in the Supporting Documents tab. See Chapter 19 for information on how to link documents to the FSPB file.

Figure 86: Questions 1b through 6b
18 Important Contacts

The CGMP & PC rule does not require a list of Important Contacts as part of your food safety plan; however, it may be useful to organize important contact information in this tab (Figure 85). For example, in the event of a product recall or other situations where swift and immediate action is required, it would be helpful to have the contact information of all relevant persons organized and readily accessible. Although the information in this tab does not automatically appear in the food safety plan, you may include it by selecting “Include Important Contacts in Plan” under the “Tools” menu. Please note that addition or removal of a supplier contact in this tab does not add or remove that supplier contact in the Supply-Chain Preventive Controls tab.

Figure 87: Important Contacts tab
19 Supporting Documents

The *Supporting Documents* tab allows you to add direct links to documents and URLs to online resources that support the food safety plan. There are no restrictions on the supporting document file types that can be added (Figure 86). To open and view a document or URL, double-click the file name. To view a supporting document, the application used to create the document must be installed on your computer. If it is not installed on the computer, the file will not open and a dialog pop-up box will appear, stating that the application needed to open the file is missing and must be installed in order to view the file.

*Note:* The description entered is used as the title of a cover page for the document when printed. Supporting documents are printed using the software tool that created the document. For example, when printing a Microsoft Word document, the FSPB tool calls on Microsoft Word to print the document. If Word is not installed, the print will fail.

The files that are added to this tab are saved under a new folder the tool creates. This newly generated folder has the same naming convention as the food safety plan file: "[Food Safety Plan File Name]"\Documents (Figure 87).

![Figure 88: Example of Food Safety file named 'Test']
If users try to access a supporting document from the FSPB file and the corresponding software to open/view this supporting document is not installed on the user’s desktop, then the following screen will be displayed.

When sharing the food safety plan, be sure to include the folder: "[Food Safety Plan File Name]"\Documents. It is recommended to send the file and folder as a zip file. If the folder in its entirety is not included, the added supporting documents will not be accessible to the recipient. In addition, if an already linked file is moved or deleted from the folder, it will no longer be accessible via the food safety plan. In order to access the file, copy the missing file into the documents folder: "[Food Safety Plan File Name]"\Documents, or, delete the link in the Supporting Documents tab and then add the file from its new location.

To print the Supporting Documents information (Figure 89), select “File”, “Export”, and “Supporting Documents”; this will print the list of all files added to the tab. Alternatively, select “File”, “Print”, and “Supporting Documents".
If this is a new food safety plan and the .fsp file has not been saved, the FSPB tool will prompt you to save the plan before adding supporting documents. Once the plan is saved, add supporting documents by:

- Selecting the add icon and choosing the desired files to link to the food safety plan
- Selecting the globe icon to add a web link (URL); when adding a URL, the FSPB application prompts users for a valid URL. Examples of valid URLs include:
  - http://www.fda.gov/foodsafety

To provide a description of the document and/or URL that was entered, select the adjacent “Description” text field and enter the appropriate information.

To delete a file or web link/URL, select the delete icon.
20 Reports

FSPB has reports that can be generated in addition to the overall Food Safety Plan:

- **Food Safety Plan** – Compiles all responses from all* of the sections within the tool into one document (*does not include information in the Recordkeeping, Important Contacts, and Supporting Documents tab or the document checklists in the Supply-Chain Preventive Controls tab, unless you have chosen to include the information from these tabs)
- **Facility Information**
- **Preliminary Steps**
- **GMP and Prerequisite Program**
- **Hazard Analysis and Preventive Controls Determination**
- **Process Preventive Controls**
- **Food Allergen Preventive Controls**
- **Sanitation Preventive Controls**
- **Supply-Chain Preventive Controls**
  - **Supplier Summary Report** - Organizes supply-chain program information by suppliers: you can view all of the ingredients provided by each supplier
  - **Ingredients Summary Report** - Organizes supply-chain program information by ingredient: users can view all suppliers of the same ingredient
  - **Supply-Chain Summary Report** - Summarizes the supply-chain program information
  - **Supply-Chain Document Checklist Report** - Summarizes the suppliers/ingredients records checklist
- **Recall Plan**
- **Recordkeeping Procedures** - Checklist of required records and actions associated with records
- **Reanalysis of Food Safety Plan**
- **Important Contacts**
- **Supporting Documents**
Reports can be generated at any time within FSPB. To export a report (Figure 90), select "File", "Export", and then select the desired report from the menu.

![Figure 92: Export a report]

20.1 Report Viewer
The reports are displayed within an embedded viewer which has a built-in toolbar along the top of the viewer window (Figure 91). The functionality includes, from left to right:

- **Navigation** — Arrow icons to proceed forward or backward through the report pages. Arrow icons with a vertical line will display the first or last page, respectively.
- **Printer** — Prints the report
- **Page Preview** — Displays the report as it will appear when printed (Figure 87).
- **Page Setup** — Customizable options (such as margins and page orientation) for how the report is to be printed
- **Save/Export** — Options for selecting a format and method for saving and exporting the report
- **Scaling** — Increase or decrease the scale of the report
Figure 93: Reports Viewer
APPENDIX A: RESOURCES AND ASSOCIATED WEB LINKS

FSMA Final Rule for Preventive Controls for Human Food

Current Good Manufacturing Practices (CGMPs)

FDA Food Safety Modernization Act (FSMA)

Registration under the FSMA

Guidance

Draft Guidance for Industry: Hazard Analysis and Risk-Based Preventive Controls for Human Food

FDA Issues Revised Draft Guidance for Control of *Listeria monocytogenes* in Ready-To-Eat Foods

Industry Guidance for Recalls

Model Recall Press Announcements.

Draft Guidance for Industry: Describing a Hazard That Needs Control in Documents Accompanying the Food, as Required by Four Rules Implementing FSMA

Foodborne Incident Information

Foodborne Illness & Contaminants

Foodborne Illnesses: What You Need to Know

Compliance & Enforcement

Recalls, Outbreaks & Emergencies

Import Alerts

Outbreaks: Investigation, Response & Evaluation

Reportable Food Registry for Industry
Training

FSMA Training

Food Safety Preventive Controls Alliance

APPENDIX B: KEY TERMS
The following table provides definitions and explanations for terms and acronyms relevant to the content presented within this document.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>FDA</td>
<td>Food and Drug Administration</td>
</tr>
<tr>
<td>FSPB</td>
<td>Food Safety Plan Builder</td>
</tr>
<tr>
<td>CFR</td>
<td>Code of Federal Regulations</td>
</tr>
<tr>
<td>FSMA</td>
<td>Food Safety Modernization Act</td>
</tr>
<tr>
<td>PCQI</td>
<td>Preventive Controls Qualified Individual</td>
</tr>
<tr>
<td>CGMP</td>
<td>Current Good Manufacturing Practices</td>
</tr>
<tr>
<td>GMP</td>
<td>Good Manufacturing Practices</td>
</tr>
<tr>
<td>PC</td>
<td>Preventive Controls</td>
</tr>
<tr>
<td>SOP</td>
<td>Standard Operating Procedure</td>
</tr>
<tr>
<td>FD&amp;C Act</td>
<td>Food, Drug, and Cosmetic Act</td>
</tr>
<tr>
<td>RTE</td>
<td>Ready-To-Eat</td>
</tr>
</tbody>
</table>